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Installation

This document provides instructions for the initial installation of the ICS-1500 Ion
Chromatography System.

NOTE The order of the steps is important. It is especially
important to install Chromeleon® before connecting the
USB cable and turning on the ICS-1500 power.

1 Facility Requirements

® Make sure the ICS-1500 installation site meets the following environmental
specifications:

Operating Temperature: 4 °C to 40 °C (40 °F to 104 °F)
Humidity: 5% to 95% relative humidity, noncondensing

*[] Provide a sturdy workbench for the ICS-1500 of a height that ensures
convenient access to the interior.

* Allow at least 15 cm (6 in) behind the ICS-1500 for power connections and
ventilation. For optimal performance, install the ICS-1500 in a draft-free
location, out of the path of air conditioning and heating vents.

® (Optional) Provide a clean gas source regulated to between 0.55 and
0.83 MPa (80 and 120 psi) for pressurization of the eluent reservoir.

® Use ASTM filtered, Type I (18-megohm) deionized water when preparing
eluent and regenerant.
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2 Unpacking the ICS-1500 System

1. After removing the ICS-1500 from the shipping box and removing the top
layer of foam, remove the next layer of foam (see Figure 1).

"~ (Remove this foam)

7
L

Figure 1. ICS-1500 After Removing Shipping Box and First Layer of Foam

2. Set the eluent bottle on top of the ICS-1500 (see Figure 2).

Figure 2. ICS-1500 with Eluent Bottle

2 Doc. 031916-01 3/03



Unpacking the ICS-1500 System

3. Remove the next layer of foam and remove the Ship Kit box (see Figure 3).

Figure 3. ICS-1500 with Ship Kit

4. The bottom foam layer has two cutouts on either side of the ICS-1500
module; use these as hand holds when lifting the module (see Figure 3).

5. Lift the ICS-1500 out of the bottom layer of foam and set it on a workbench.
Inspect the ICS-1500 for any shipping damage.

Two or more persons should lift the ICS-1500, which weighs 30 kg
(66 Ib). Lift the ICS-1500 only from each side of the cabinet bottom.
Lifting from the front door will damage the door hinges.
CAUTION
Au moins deux personnes peuvent soulever le ICS-1500: il pése 30 kg
(66 Ib). Ne soulevez le ICS-1500 que par chaque cété du fond de
I'armoire. Son soulévement par la porte du panneau avant
MISE EN GARDE endommagera les charniéres de la porte.

Der ICS-1500 wiegt tiber 20 kg. Daher sollte das Gerat nur von zwei
oder mehr Personen angehoben werden. Greifen Sie dazu an beiden
Seiten unter das Gerdt. Heben Sie den Autosampler nicht an der

VORSICHT Vordertiir an, da dadurch die Tiirangeln beschadigt werden kénnten.
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2.1

2.2

Unpacking the Computer (North America only)

4.

NOTE These instructions assume that Chromeleon
software and the software license were installed on
the computer before shipping.

Remove the central processing unit (CPU), keyboard, mouse, and all
documentation from the computer box and place these items on a
workbench.

Remove the monitor from its box and place it on the workbench.

Follow the instructions in the computer installation guide to hook up
the monitor, mouse, keyboard, and CPU.

Go on to Section 4, “Installing the Chromeleon Software License.”.

Unpacking the Computer (outside North America)

L.

Refer to Installing the Chromeleon IC System (Document No.
031883) to verify that the computer being used meets Chromeleon
specifications. The manual is on the Dionex Reference Library CD-
ROM (P/N 053891).

Remove the central processing unit (CPU), keyboard, mouse, and all
documentation from the computer box and place these items on a
workbench.

Remove the monitor from its box and place it on the workbench.

Follow the instructions in the computer installation guide to hook up
the monitor, mouse, keyboard, and CPU.

If Chromeleon is not installed on the computer, go on to Section 3,
“Installing Chromeleon.”

If Chromeleon is already installed on the computer, go on to
Section 4, “Installing the Chromeleon Software License.”
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3 Installing Chromeleon

NOTES

10.

Windows® 2000 or Windows XP is required for controlling the ICS-1500
with Chromeleon.

To install Chromeleon, you must log onto Windows 2000 or XP with
administrator privileges. Administrator privileges are not required to
run Chromeleon.

Turn on the computer power.
Follow the Windows setup steps as they appear on the screen.

Verify that the monitor display is set to a minimum of 1024 x 768 with 16 bit
color.

Insert the Chromeleon CD-ROM into the CD-ROM drive.
The Chromeleon Setup menu appears.

If the Setup menu does not appear automatically, go to the Autorun folder on
the Chromeleon CD-ROM and double-click autorun.exe.

Select Launch Chromeleon Setup.

Setup now guides you through the installation procedure; follow the on-
screen instructions as they appear.

When prompted, select whether to add the Chromeleon Server Monitor to the
Startup group. If you select yes, the Server Monitor starts automatically when
the computer is started, and the program icon appears in the taskbar.

When complete, go on to Section 4, “Installing the Chromeleon Software
License.”
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IMPORTANT

Installing DX-LAN Devices

If you will also be installing a module that requires a DX-LAN interface
connection, verify that the following steps are completed before continuing:

1. Ifitis not already installed, install the DX-LAN card in the module. Refer
to the operator’s manual for the module for installation instructions.

2. Install the DX-LAN card in the computer.
3. Connect the module to the DX-LAN.
4. Install the DX-LAN card driver.

Instructions for Steps 2 through 4 are in Installing the Chromeleon IC System
(Document No. 031883).

4 Installing the Chromeleon Software License

For the Chromeleon computer to control the ICS-1500, a valid software license
must be installed. To install the license, you first install a dongle on the computer
and then enter a license “Key Code” in Chromeleon. (A dongle is an adapter that
is connected to the parallel PC interface or USB port. The dongle stores the serial
number of a Chromeleon computer.)

NOTE If the software license is managed via a License
Server, a dongle is not required.

1. Plug the dongle into the appropriate port on the computer (either the parallel
or USB port, depending on the type of dongle). Tighten the connector screws
on a parallel port dongle.

2. Ifitis not already running, start the Chromeleon Server Monitor (select
Start>Programs>Chromeleon>Server Monitor). The Server Monitor
window opens.
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Installing the Chromeleon Software License

3. Check the server status:

® [f“Chromeleon Server is running idle” is displayed, the license Key Code
was entered before shipping the computer, and you can omit the
remaining steps in this section. Click Close and go on to Section 5.

® If “Chromeleon Server is running idle (Evaluation Mode)” is displayed
(see Figure 4), the license Key Code has not yet been entered. If this is the
case, go on to Step 4.

% Chromeleon Server Monitor =15 =]

Status e |
e =

G #22 [Chiomelzon Server is running idle (Evaluation Mods). |
Help

il Guit b onitor |

Config... |

Serial Mo B48

Figure 4. Server Evaluation Mode

4. Open Chromeleon (select Start>Programs>Chromeleon>Chromeleon).
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5. Select File>Preferences to open the Preferences dialog box (see Figure 5).
Select the License tab and click Dongle. Enter the Key Code exactly as it
appears on the Chromeleon Software License key code sheet. Click OK.

Spectra Thumbnails | AMT Editar I Spectra Library I
Browser License | Grid I Server

Fey Code: IFXXH->< - DA

— Copy Protection Location

€ None [Evaluation Mode]

" Hardpratect 140 ID:-:EIEEIF 3:
" Dionex &0 Converter 140 ID:-:|331-'1 3:

' UYD 340541705 Interface 1/0 |D>:0318 3:

€ Pump Control Card 140 IUHU3UU 3:

* Daongle

€ License Server I.t’-‘-.T-EIEI J
ok I Cancel | el |

Figure 5. Preferences: License Page

6. Check the Server Monitor status. It should now display “Chromeleon Server
is running idle.” (see Figure 6).

‘4 Chiomeleon Server Monitor HE B

Status Close |

Ll |Ehru:|meleon Server iz running idle.
Help |

Lot Monitar |

Config... |

SEart

Serial Mo: - B48

Figure 6. Server Running

7. Click Close to close the Server Monitor window.

8. Go on to Section 5.
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5 Connecting the ICS-1500 to the Chromeleon PC

The ICS-1500 rear panel provides a USB receptacle for connecting the ICS-1500
to a USB port on the Chromeleon PC. The rear panel also provides two USB ports
for connecting other Dionex USB-compliant modules to the system.

Do not turn on the power to the ICS-1500 or other USB module(s) until
IMPORTANT after you connect the USB cable.

Before connecting the USB cable, verify that Chromeleon is installed.
If not, Windows will be unable to identify the new USB device when
the power is turned on. See Section 3 to install Chromeleon.

5.1 Connecting the ICS-1500 to the PC

1. Locate the USB cable (P/N 960779) in the ICS-1500 Ship Kit
(P/N 057905).

2. Plug the cable’s “A” connector into a USB port on the Chromeleon
PC and plug the cable’s “B” connector into the USB receptacle
(labeled FROM PC) on the ICS-1500 rear panel (see Figure 7).

ICS-1500| §

Chromeleon PC

Plug the USB cable’s “B” Plug the USB cable’s “A”
connector into the FROM PC connector into the USB
receptacle on the ICS-1500. port on the Chromeleon PC.

FROM PC USB receptacle
on the ICS-1500 rear panel

Figure 7. Example Connections: One ICS-1500 Connected to the Computer
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5.2 Connecting Additional USB Devices

The ICS-1500 provides two USB ports for connecting additional Dionex
USB-compliant modules to the system.

To connect an additional USB module, plug the “A” connector on a USB
cable into an “A” port (labeled TO MODULE) on the ICS-1500 rear panel
and plug the cable’s “B” connector into the USB receptacle on the USB
module (see Figure 8).

B
1CS-1500 _A_—j
A \

USB Cables A
J k \—‘ Chromeleon PC

Dionex

Dionex

uUsB
Module

usB
Module

Figure 8. Example Connections: Two Dionex USB Modules Connected to the ICS-1500

NOTE If the number of USB devices in the system exceeds the
number of available USB ports, connect the devices to
the system with a USB-compliant, full-speed external
hub. One or more hubs is also required if the ICS-1500
or other USB device is more than 5 meters (16 ft) from
the PC. Refer to the manual provided by the hub vendor
for complete installation instructions.

The USB standard limits the USB cable length to 5 meters (16 ft). Each

IMPORTANT] USB device can be separated from the PC by no more than five hubs.
Thus, each USB device can be located no more than 30 meters

(32 yds) from the PC.
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Connecting the Power Cord

6 Connecting the Power Cord

Connect the power cord (IEC 320 C13) (ordered separately) from the main power
receptacle on the rear panel to a grounded power source. The ICS-1500 power
supply is auto-sensing, so no adjustment is required to select the line voltage.

SHOCK HAZARD—To avoid electrical shock, use a grounded
receptacle. Do not operate the ICS-1500 or connect it to AC power
mains without an earthed ground connection.

P>

WARNING

The power supply cord is used as the main disconnect device. Make
sure the socket-outlet is located near the ICS-1500 and is easily
accessible.

P>

CAUTION

Operation at AC input levels outside of the specified operating voltage
range may damage the ICS-1500.

P>

CAUTION

DANGER D'ELECTROCUTION—Pour éviter toute électrocution, il faut
utiliser une prise de courant avec prise de terre. Ne l'utilisez pas et ne

le branchez pas au secteur C.A. sans utiliser de branchement mis a la
AVERTISSEMENT terre_

P>

Le cordon d'alimentation principal est utilisé comme dispositif
principal de débranchement. Veillez a ce que la prise de base soit
situéelinstallée prés du module et facilement accessible.

P>

MISE EN GARDE

STROMSCHLAGGEFAHR—Zur Vermeidung von elektrischen
Schlagen ist eine geerdete Steckdose zu verwenden. Das Geriat darf
nicht ohne Erdung betrieben bzw. an Wechselstrom angeschlossen
WARNUNG  Wwerden.

Das Netzkabel ist das wichtigste Mittel zur Stromunterbrechung.
Stellen Sie sicher, daB sich die Steckdose nahe am Gerit befindet und
leicht zuganglich ist.

> P

VORSICHT
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7 Turning On the ICS-1500 Power

Before turning on the ICS-1500 power, verify that Chromeleon

IMPORTANT| software is installed. See Section 3 for installation instructions. If

Chromeleon is not installed first, Windows will be unable to identify
the new USB device.

1. Ifitis not already on, turn
on the computer power and
log onto Windows 2000 or T il —
Windows XP as an ] :

administrator. Power
i B Switch

2. Press the power switch on
the ICS-1500 rear panel (see II"““""

Figure 9) to turn on the
povr il

i

Figure 9. ICS-1500 Rear Panel

3. Windows automatically detects the new USB device. A message flashes on
the screen to inform you that new hardware was found.

=101x]

#% Chromeleon Ser

ﬁ IC5-1000/2000 lon Chromatography Systern
I

Irniztalling ...

| Lonhg...

4. Go on to Section 8.
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Setting Up Chromeleon

8 Setting Up Chromeleon

NOTE This section provides brief instructions for setting up
Chromeleon. For details about any of these steps, refer
to the Chromeleon user’s guide or online Help.

8.1 Assigning the ICS-1500 to a Timebase

1. Ifthe Chromeleon Server is not running (the icon on the taskbar is

crossed out in red % ), start the Server by right-clicking the icon
and selecting Start Server. When the server starts, the icon changes

to gray % .

2. Open the Server Configuration program (select
Start>Programs>Chromeleon>Server Configuration).

3. The Unassigned USB Devices dialog box appears (see Figure 10).

Unassigned Dionex IC USB Devices Detected E

The zoftware haz detected USE devices which are not aszigned to a Timebase. Y'ou may add the devices
to an existing Timebaze, create a new Timebaze for these devices, or zsimply press the "Cancel” button to
postpone assigning the module.

Server Mame: AMAR

—Unassigned USE Devices———————————— — Timebase

IC5-1500: 200011

Azzighed Devices

Dionex AS1-100 Autasampler
Diionex PRE0 Pump
Diones WD 3405 FDA

LS =

<o Urassign |

Elasiadie | Hew Eelete

= [Laurich Senven Eanfiguration orib

ak. I Cahicel |

Figure 10. ICS-1500 Unassigned to Timebase
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Click the New button.

The Timebase box displays a default name (the Server Configuration
name). You can use the provided name or type a new one (for
example, ICS-1500).

Press the Enter key.

In the Unassigned USB Devices box, select the ICS-1500 and then
click the Assign button. The ICS-1500 is now assigned to the
timebase (see Figure 11). If you are installing more than one ICS-
1500, you can verify the serial numbers for each by checking the label
on the component panel. The serial number is also shown on the
INFORMATION touch screen page.

Repeat Step 7 if you are adding additional USB devices to this
timebase.

Unassigned Dionex IC USB Devices Detected =]

The software haz detected USE devices which are not aszigned to a Timebasze. vYou may add the devices
to ah existing Timebase, create a new Timebaze for theze devices, or simply press the "Cancel” button to
poztpone azsigning the module,

Server Mame: AMaR

— Timebage

— Unazzigned USE Devices

Agzigned Devices

: |CS-1500; 200011
)

< [Inasaian

|

ElastModile | Hew Lelete

™| LAt Senver Eomfiguration ot D

QK. I Cancel

Figure 11. ICS-1500 Assigned to a Timebase

14
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Setting Up Chromeleon

1

9. Click OK to close the dialog box. The Server Configuration program

window appears.

10. Click the + icon next to the server name to expand the folder. The
timebase you created is displayed (see Figure 12).

#% server Configuration - Chromeleon Server Configuration

File Edit Wew Server Help

B L R RN A D N v
5---,_IEI,AMAR

------ g’ Sharable Devices
(- DEMO

=1-§1)
- Dionex [05-1500 System

Figure 12. Server Configuration with ICS-1500 Timebase

1. To verify that the ICS-1500 is correctly connected to the timebase,
double-click its name under the timebase. Click Yes if the following
message appears: “Communication to the device will be stopped...Do
you want to continue?”’

Doc. 031916-01 3/03
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8.2

12. The ICS-1500 System dialog box opens (see Figure 13). The General
page shows the Device Name (Pump_ECD), the Mode (Live), and
the Module Serial No.

Dionex ICS-1500 System E

Error Levels I Dema Chromatagranm I TTL Inputs I Trend I Calibration I Diagnostics
General | Optioks I Signals I Head Type & Limits I Solvents I State Devices

Device Name: SN0

~ Mode
& Live
Module Serial Mo: | 200011 B
todulewware version: I 0. 327 Download... |
€ Wirkual

Usge Live mode to control a physical module connected to the server,
*irtual mode can be uzed to demonztrate the zoftware support for
the module and allows one ta create methods and panels without
having a phyzical module attached to the zerver.

QK I Cancel | S | Help |

Figure 13. ICS-1500 System Properties

13. Close the dialog box and then save the configuration (select
File>Save Installation).

14. Ifyou are going to add one or more DX-LAN devices to the timebase,
go on to Section 8.2. Otherwise, exit the Server Configuration
program and then go on to Section 9.

Assigning DX-LAN Devices to the Timebase (Optional)

Follow the instructions in this section if you are adding one or more
devices to the timebase that are connected to the PC through a DX-LAN
interface (not through USB connections).

1. Follow the instructions in Installing the Chromeleon IC System
(Document No. 031883) to add the DX-LAN card to the server
configuration as a sharable device.

16
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Setting Up Chromeleon

dd device to timebase

Timebase Name:

Manufacturers:

General

ABI
Agilent
Antec
Berthald
BIC-RAD
CTC
Dostmann
Esza

Fisons
[ ENTNeY

Select the timebase that was created for the ICS-1500 (see Figure 14);

then, click the Add device icon % on the toolbar (or select
Edit>Add Device).

%% server Configuration - Chromeleon Server Configuration
File Edit

Views Server Help

BE 2R PN
= & amar

Sharable Devices

EEDFE NV

DEMO

- g Dionex IC5-1000 System

Figure 14. Example: ICS-1500 Timebase

The Add device to timebase dialog box appears.

If it is not already selected, select Dionex under Manufacturers and
then select the device from the Devices list.

BiolLC

Dewvices:

Ze ADZ0 Detector
ADZ5 Detector
50 Autosampler;
AS100 Autosampler

as) CD20 Detector

A CD25 Detector

o) CD25A Detectar

=2 D120 System
e EDA0 Conductivity Detector
92 Fr4n N Amn_Netertar

oK | Cancel |

Figure 15. Add Device to Timebase Dialog Box

Doc. 031916-01 3/03
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4. Click OK. A configuration properties dialog box for the device
appears. Figure 16 shows an example of the properties for an AS50

Autosampler.
Dionex AS50 Autosampler E
Errar Levels | Calibration | Diagnostic |
General | Options I Temperature I Devices

Device Name:  |EENEE

™ Demo Mode

— Communication

Device |D:

INone J
Buemy far Device 1D |

Device Senial No:

Figure 16. AS50 Configuration Properties

5. On the General tab page, clear the Demo Mode check box if it is
currently selected, and then select the DX-LAN Device ID number.
Note: Devices display their DX-LAN ID numbers when their power
is turned on.

Click OK to close the dialog box.
Save the configuration (select File>Save Installation).

Exit the Server Configuration program.

o »® =N

Go on to Section 9
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Installing and Plumbing the Columns and Suppressor

9 Installing and Plumbing the Columns and Suppressor

NOTE This section provides brief installation and plumbing
instructions for the columns and suppressor. Before
beginning the installation, refer to the column and
suppressor manuals for detailed start-up and
installation instructions. The manuals are provided on
the Dionex Reference Library CD-ROM (P/N 053891),
which is located in the ICS-1500 Ship Kit (P/N 057905).

Before beginning:

* Remove the guard column, separator column, and suppressor from their
boxes.

* Remove the fitting plugs from the ends of each column and from all ports on
the suppressor.

® Discard any tubing temporarily connecting the suppressor ports.

9.1 Column Heater Setup

1. Cut off the two
shipping ties from
the column heater
and remove them

(see Figure 17).

2. Loosen the two
thumbscrews on
the heater cover
(they remain
attached to the
cover).

3. Pull the heater
cover straight out
to remove it.

Figure 17. ICS-1500 Column Heater Setup
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9.2

4. Unscrew the six

thumbscrews on the
top metal plate (see

Figure 18) and

remove the plate. Thumbscrew (6)

Go on to
Section 9.2.

Figure 18. ICS-1500 Column Heater Cover Removed

Installing the Columns

S kW

Remove the union connecting GUARD IN and GUARD OUT.

Connect GUARD IN to the guard column inlet. Check the arrow on the
column label; it should point down (flow away from the injection
valve).

Connect GUARD OUT to the guard column outlet.
Push the guard column onto the back column clip.
Remove the union connecting COL IN and COL OUT and

Connect COL IN to the separator column inlet. Connect COL OUT to
the separator column outlet. Check the arrow on the column label. It
should point up (flow toward the cell).

Push the separator column onto the front column clips.

Replace the top metal plate on the column heater.

20

Doc. 031916-01 3/03




Installing and Plumbing the Columns and Suppressor

9.3 Installing the Suppressor

1. Locate the suppressor
mounting tabs on the
component panel (see
Figure 19). Reach into
the opening between the
tabs and pull the yellow
connector and attached
cable slightly out of the
opening.

1 Suppressor
Mounting Tabs

2 Suppressor Cable
Connector

3 Guideline for AES
2. Connect this cable to the 4 Guideline for SRS
cable from the
suppressor (align the
pins on the two
connectors and push
them together).

Figure 19. Suppressor Mounting Tabs
and Guidelines

3. Orient the suppressor with the REGEN OUT fitting on top and the
cable to the right.
4. Feed the cable into the opening in the component panel.

5. Align the top of the suppressor with the guideline printed on the
component panel (see Figure 19) and align the slots on the rear of the
suppressor with the tabs on the panel.
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10.

Press the suppressor onto the tabs
and then slide it down to lock it in
place. Pull slightly on the center of
the suppressor to verify that it is
securely fastened. Figure 20 shows
an SRS suppressor installed on the
component panel.

Remove the union connecting
ELUENT IN and ELUENT OUT and
connect these lines to the
corresponding ports on the
SUppressor.

Figure 20. Suppressor Installed
(SRS Shown)

Remove the fitting plug from REGEN IN and connect it to the REGEN
IN port on the suppressor. Connect the TO SRS/AES REGEN OUT line
to the REGEN OUT port on the suppressor.

Replace the cover on the column heater, making sure the GUARD IN
line is aligned with the slot on the side of the heater cover.

Go on to Section 10.

22
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10

Connecting the Waste Lines

The ICS-1500 has the following waste lines:

® PUMP WASTE carries prime waste from the pump.

® TO WASTE OUT carries sample overflow from the injection valve.

® WASTE, GAS SEPARATOR carries system waste from the suppressor.

Untape the coiled waste lines from the rear panel. Place the ends of the PUMP
WASTE and TO WASTE OUT lines into a waste container.

Direct the WASTE, GAS SEPARATOR line from the top of the ICS-1500 to the rear
panel. Snap the line onto one of the tubing clips on the rear panel. Connect the line
to the gas separator waste tube (see Section 10.1).

NOTE To prevent waste from siphoning back into the system,
check the lines periodically to be sure they are not bent,
pinched, or elevated at any point.

10.1 Installing the Gas Separator Waste Tube

1. Locate the gas

separator waste tube = ’“{ﬁi Connect the
assembly (see WASTE, GAS
Figure 21) in the ﬁE;ARATOR line
ICS-1500 Ship Kit

(P/N 057905).

2. Connect the WASTE,
GAS SEPARATOR
line to the 3-mm
(1/8-in) ID white
Teflon tubing on the
gas separator waste
tube assembly.

Figure 21. Gas Separator Waste Tube Assembly

3. Place the gas separator waste tube assembly into the waste container.
Make sure the tubing junction (where the white Teflon tubing meets
the black polyethylene tubing) is above the top of the container and
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that the gas separator waste tube and the waste container are open to

the atmosphere (see Figure 22).

4. Go on to Section 11.

Waste, Gas
Separator Line

Gas Separator

Waste Waste Tube Assembly

Container

CAUTION

MISE EN GARDE

Figure 22. Gas Separator Waste Tube Installation

DO NOT CAP THE WASTE CONTAINER: The ICS-1500 uses an
electrolytic process that results in the production of small amounts of
oxygen or hydrogen gas. To ensure that the gas is not trapped in a
closed container and allowed to concentrate, install a 1.3-cm (0.52-in)
ID black gas separator waste tube (P/N 045460) in an uncapped waste
container. Connect the Waste, Gas Separator line to the waste tube

(see Figure 22).

NE FERMEZ PAS LE CONTENEUR DE GAZ RESIDUEL L : Le ICS-1500
travaille avec un proces d’électrolyse, qui produit des petites
quantités de gaz d’oxygéne ou d’hydrogéne. Afin de garantir que le
gaz ne soit pas enfermé dans un conteneur fermé et puisse s’y
concentrer, connectez un tube noir a gaz résiduel (diamétre intérieur =
1,3 cm ; n° de commande 045460) a un conteneur ouvert (non fermé).
Connectez le conteneur résiduel au tube résiduel/gaz séparateur
(désigné: « Waste, Gas Separator»).

24
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VERSCHLIESSEN SIE DEN ABFALLBEHALTER NICHT: Der ICS-1500
verwendet einen Elektrolyseprozess, wodurch kleine Mengen an
Sauerstoff und Wasserstoff entstehen. Fiihren Sie einen schwarzen
Gasabscheiderschlauch (ID = 1,3 cm; Bestell-Nr. 045460) in einen

VORSICHT offenen (unverschlossenen) Abfallbehilter, damit sich das Gas nicht
in einem geschlossenen Behalter sammelt und aufkonzentriert.
Verbinden Sie die mit Waste, Gas Separator bezeichnete Leitung mit
dem Abfallschlauch.

11 Setting Up the Eluent Reservoir

1. Rinse the eluent reservoir.

2. Prepare the eluent as instructed in the manual for the column being installed.
The column manual is included on the Dionex Reference Library CD-ROM
(P/N 053891), located in the Ship Kit.

3. Fill the reservoir with the prepared eluent.
4. Place the reservoir on top of the ICS-1500.
5. Install the cap and hand tighten.
NOTE The ICS-1500 does not require pressurized reservoirs.
However, if eluent is manually degassed or is sensitive to
contamination, Dionex recommends pressurizing the

reservoir with helium or nitrogen. See Section 20 for
instructions.

6. Go on to Section 12.
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12  Setting Up a Chromeleon Application

Chromeleon provides application templates, which you can use to quickly get
started running. To use the application templates, you need to know the type of
column and suppressor you will be using. This section shows how to create a list
of samples to be processed (a sequence) and how to use an application template.

1. Identify the type of column and suppressor installed in the ICS-1500.

2. Start Chromeleon (select Start>Programs>Chromeleon>Chromeleon).
The Chromeleon main window and Browser appear (see Figure 23).

% Chromeleon - AMAR _local'\Dionex Templates - Browser

Fil=  Edit Wiew ‘Workspace gualification Babch Window Help
DEHEE R bz Lns (xR
koAb o by R O R G| Edit Batch...

EAMAR _local\\Dionex Templates - Browser

E--ﬁ AMAR_local Mame / |Last Update

= (0 DEMO [ I© Applications 22003 111832 A
[ AupIT [C] Panelz 1/5i2003 3:05:51 PM
[Z] Reports 20452003 111832 &

¢ Templates
kions

E [ Reports

=3 1C5-1500
B2 AUDIT
o manal

Figure 23. Chromeleon Main Window and Browser
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3. In the Browser, select File>New and select Sequence (using Wizard) (see

Figure 24).

K.

{Seguence (using Wizard)
Seguence (from LIMS Worklist)
Query (using Wizard)

Program File

tethod File

Spectra Library

Cancel

OZ
m
S|z
S
=
i}
=
l
ttl
[ %

Help

Figure 24. Creating a New Sequence

The Sequence Wizard Welcome page appears (see Figure 25).

Chromeleon Sequence Wizard: Welcome

Welcome to the

Sequence Wizard

Thiz wizard helpz pou to create a sequence. [t will guide pou through

the following steps:

o Choose a timebase
o Specify standards and unknownz
o Select method files
o Store the sequence

To continue, click Mext.

Cancel

Help

Figure 25. Sequence Wizard Welcome Page
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NOTE For details about a Sequence Wizard step, click the Help
button on the Sequence Wizard page.

4. Click Next>.
The Sequence Wizard Timebase page appears (see Figure 26).
Chromeleon Sequence Wizard - Step 1 of 5: Timebase E

Chooze a Timebase
Select the timebasze where the sequence will run,

Timebaze:
||cs-1 500

LCamputer:
|AMAF|

Favorites
Metwork, Meighborhood
PBratocal:

IM_I,I Computer j

Enter connection information
manually or pick a timebaze from
the lizt at right.

< Back I MHeut » I Cancel | Help

Figure 26. Example: Sequence Wizard Step 1

5. Select the ICS-1500 timebase and click Next>.
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The Unknown Samples page appears (see Figure 27).

Chromeleon Sequence Wizard - Step 2 of 5: Unknown Samples E
Unknown Samples
Generate zamples from a template o import them via clipboard or from another sequence
T [— | Sequence Preview | Fack F'reviewl .
MHane | Pos. | Wal. |
Template far Sample Mame:
j 3 |
Mumber of Wials: ID [1..%]
Injections per Yial; I1 [1...99]
Start Position; I1 [1...99339]
Injection Yolume:  [20.00 [0.1...100000.0 pi]
Apply > I
< Back | MHeut » | Cancel | Help

Figure 27. Example: Sequence Wizard Step 2

6. Select Use Template from the drop-down list.

7. In the Template for Sample Name field, type Sample, click the right arrow,
and select Sample Number #n.

8. In the Number of Vials field, type 1.
9. Use default settings for the remaining parameters on the page.

NOTE You can edit the sequence later, to add more samples

and select the injection parameters appropriate for your
application.
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10. Click Apply.
Figure 28 shows Sequence Wizard Step 2 after a sample is defined.

Chromeleon Sequence Wizard - Step 2 of 5: Unknown Samples

Unknown S5amples
Generate samples from a template or import them via clipboard or fram another sequence

Sequence Preview i
IUse template j [riport... | ; | e F'rewewl i

Mame | Pog. | Wal, |
Template for Sample Name: @ Sample 1 1 200

ISampIe fn j ;I
Murnber of Yials: |1— [1...x]
Injections per Yial: |1— [1..99]

Start Pozition: |1— [1...99939]

Injection Wolame: |2':'-D [0.1..100000.0 0

Apply rx

< Back I Ment » I Cancel | Help

Figure 28. Example: Sequence Wizard Step 2 with Sample Defined

11. Click Next>.
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The Standard Samples page appears (see Figure 29).
Chromeleon Sequence Wizard - Step 3 of 5: standard Samples E2

Standard Samples

Generate standardz from a template or import them via clipboard or from another zequence

s tomplole [ | Sequence Preview | Fack Preview | :
M arme | Pos. | Wl |
Template for Sample Hame; @ Sample 1 1 200

=i
Mumber of Wials: ID [1...x]
Injections per Yial; I1 [1...99]

Start Position; |99 [1...99939]
Injection Yolume:  |20.0 [0.1...100000.0 pl]

[ Variation: |'| Standard(z]
aftern each |1 W rikrmasmls]

Apply >

< Back I Mewut » I Cancel | Help |

Figure 29. Example Sequence Wizard Step 3

12. Click Next> to omit this step and define standard injections later. Or, define
one or more standard injections, and then click Next>.

The Methods & Reporting page appears
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13. Select the Use Application Template check box.

14. From the drop-down lists, select the type of suppressor to be installed and
then select the column.

In the example in Figure 30, the 4-mm ASRS suppressor and AS17 column
are selected.

Chromeleon Sequence Wizard - Step 4 of 5: Methods & Reporting E

Methods & Reporting
Specify a method or select a pre-defined template, and indicate reporting preferences.

— Applications (includes method)

¥ Use Application Template Suppressor Type IASHS_4mm vl

I.&S1 T Production Test Chromatogram j

= ethiad les

Brogran: I.l’-‘n.51 7 Production Test Chromatogram j Browse... |
[uantifieationm i ethod: IAS'I ¢ Praduction Test Chromatogrann j Browss... |

e progran atd auattticaton fes il beimperted (copred] inta e new seauence)

— Preferred Reparting Options

Preferred Report: IT_|DCEI|'\DiDnB:-: Templates'\Heports'\defaultj Browse... |

Preferred Channel: I j

These settingz are uzed when vou print a report for the sequence or double-click. a zample.

< Back I MHeut » I Cancel | Help

Figure 30. Example: Sequence Wizard Step 4

15. To select a report template, click the Browse button, go to the Dionex
Templates/Reports folder, and select a template (for example, default_letter).

16. Click Next>.
The Saving the Sequence page appears.
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17. Enter a name for the sequence and a location (see the example in Figure 31).
Chromeleon Sequence Wizard - Step 5 of 5: Saving the Sequence

Saving the Sequence
Specify where to save the seguence. Press Mest to zave it.

—Mame & Title
Remember ta enter a new seguence name, unless you want to ovenarite an old sequence.

Seguence Mame: IInstaIIatinn Exampld

[
[

Title: |

 Location
Datazource: IAM AP _lacal j

Directony: I ﬂ Browsze. . |

< Back I Hewt » I Cancel | Help |

Figure 31. Example: Sequence Wizard Step 5

18. Click Next> and then click Done on the last page of the Sequence Wizard.

The Browser appears, displaying the sequence you created (see Figure 32).
Notice the three files in the top pane of the Browser window.

EAMAR_Iol:aI"-.,"-.,Insl:allal:ion Example - Browser

E@ AMAR._local Mame: J | Title: Timebase La
D DEMC *F 8517 Production Test Chromatogram pom AS17 dmm Production Test Chromatogra 125-1500 arz
-] Dionex Templates | 2317 Production Test Chromatogram.ant 7z
(] 1C5-1500 [ 1cs-1500_System pan 27
423 Installation Example

<| ! >
Mo. [Mame IType |P03| Inj. %al. | Program Method |Status |Inj. Dt -
1 @ Sample 1 |Unkn0wn 1 200 A517 Produ AS17 Produ Single

of
[« | >

Figure 32. Example Browser with Open Sequence
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The .pgm file (program) contains commands and parameters for controlling
the ICS-1500, controlling the autosampler (if used), and acquiring sample
data.

The .qnt file (quantification method) contains peak identification and area
determination parameters.

The .pan file (Control Panel) lets you control and/or monitor the ICS-1500
and other modules that are connected to the timebase.

NOTE The sequence that you create here is intended as a
starting point only. You can add additional samples to
the sequence, change injection parameters, and edit the
.pgm and .qnt files. Refer to the Chromeleon online Help
for details.

NOTE After completing the installation, see Chapter 3 in the
ICS-1500 operator’s manual (Document No. 031857) for
how to process the samples and standards in the
sequence. The manual is on the Dionex Reference
Library CD-ROM (P/N 053891).

34
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19. Double-click the .pan file to open the Control Panel for your system (see the
example in Figure 33).

% 1C5-1500 System with Column Heater - 1C5-1500 - AMAR

=10l x|

ICS-1500 Column Heater:
£

Temperature:

Heater Settings...

0.096 uS

Suppressor

Tl om

8.0

ELS

6.0

4.0

20

-1.0

1CS-1500 Pump Sampl System Log [Audit Trail] on 1CS-1500
ump - On D cer | ] 17:04:43 User [AMar) frorm AMAR -
u 800 psi . hasz connected ta timebase 1C5-1500.
Sequence: | | @17:04:49 User (AMar) from AMAR
- Sample: |:| has acquired cantrol over timebase 1C5-1500
Pump Settings... Progam: | =
1CS-1500 Injec Elapsed Program Time: | || g 1500 Syst
EE Total Program Time: I:l ¥ Connected Startup | Shutdown| Show Plutl
Load Inject 100 # from Pos.
Injector Settings...

Detector Settings...

T
0.00

12.1

Figure 33. ICS-1500 System Control Panel Example

NOTE If the Connected check box is not selected, click the box

to connect the ICS-1500 to the Control Panel.

Verifying Chromeleon Communication

Verify that Chromeleon is communicating with the ICS-1500 by clicking

the Inject and then the Load button on the Control Panel. If

communication is occurring, you will hear the valve actuate as it changes

position.

Go on to Section 13.
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13  Setting the Eluent Level

After filling the reservoir, open the HOME page and enter the volume of liquid in
the reservoir in the Eluent Level field (see Figure 34), or enter the volume in the
Eluent Bottle field on the Chromeleon Control Panel (see Figure 35). The ICS-
1500 determines the eluent usage, by monitoring the flow rate and the length of
time the pump is on, and updates the field as the eluent is used up. A warning is
displayed if the level falls below 200 mL. The warning is repeated at 100 mL and
at O mL.

In order for the eluent level displayed on the screen to be accurate,

lIMPORTANT] the level must be entered by the user when the reservoir is filled. The
ICS-1500 does not automatically detect when the reservoir is filled,
nor when it is empty.

Enter the volume of Eluent | evel Note: The Eluent Level
liquid in the reservoir ——_| 2 DD |- field is updated as the
% liquid is used up.

Figure 34. Home Page: Setting the Eluent Level

-Eluent Bottle
_Enter the volume of " Note: The Eluent Bottle
liquid in the reservoir - H field and slider gauge
-4 are updated as the
- liquid is used up.
-2
-0

Figure 35. Chromeleon Control Panel: Setting the Eluent Level
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14  Priming the Pump

1. Verify that the eluent reservoir is filled, the reservoir cap is installed and hand
tightened, and the liquid line from the ICS-1500 to the reservoir cap is
connected (see Section 11).

2. Verify that the waste lines are directed to a waste container.
3. The priming procedure consists of two parts:

* Priming the eluent lines with a syringe. Perform this procedure at initial
installation, after changing eluents, or when eluent lines are empty.

®  Priming the pump heads with the Prime button. Perform this procedure
after the eluent lines are primed.

14.1 Priming the Eluent Lines with a Syringe

NOTE Prime the eluent lines after initial installation, after
changing eluents, or when eluent lines are empty.
1. Verify that the pump is turned off.

2. Connect a 10 mL syringe (P/N 054578) to the port in the priming
valve on the primary pump head (see Figure 36).

Secondary
Pump Head

Waste Valve
(close)

Primary
Pump Head

10 mL Syringe Priming Valve
(P/N 054578) (open)

Figure 36. Priming the Eluent Lines
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Open the priming valve by turning it one-quarter to one-half turn
counterclockwise.

On the Chromeleon Control Panel, click Pump Settings and then
click Eluent Flow Valve Open (see Figure 37).

g’;g 1C3-1500 System with Column Heater

ICS-1500 P

ICS-1500 - AMAR

p ! ystem Li
ump-On—————— 1500 Pump Settings 5-00:;
B 800 psi ‘Pump Settings has co
Flow Rate: BT et B::-SDEC
Pump Settings... -Eluent Bottle—  off | On | e |
0.001 5
1CS-1500 Inject I:_da Eluent Flow Valve 51500 '
EE LoadPosition : { Closed Open | ¢ Conne
Load | Inject £ Max. Pressure: | 5000 psi
. . L2
Injector Settings... : Curr. Pressure: | 800 psi
1 : .
1CS.1500 Col Heat i Min. Pressure:
ig .
Temperature: Eluent Level:
35.0 °C |

Heater Settings... |

Figure 37. Chromeleon Control Panel: Pump Settings

5.

Draw the syringe back to begin pulling eluent through the flow path.
It may take several syringe draws to remove all air or previous eluent
from the tubing.

NOTE If the vacuum degas assembly is installed, draw
out an additional 20 mL of eluent.

After priming the lines thoroughly, close the priming valve. Do not
overtighten the priming valve.

Close the eluent valve (click Eluent Flow Valve Closed on the
Control Panel).

38

Doc. 031916-01 3/03



Priming the Pump

14.2

Priming with the Prime Button

NOTE Perform this procedure after priming the eluent

lines (see Section 14.1).

Check that the priming valve on the primary pump head is closed (see
Figure 38).

Pump Head

Waste Valve

Secondary

(open)

Primary
Pump Head

Priming Valve
(close)

Figure 38. Priming the Pump

Open the waste valve on the secondary pump head by turning the
knob one-quarter to one-half turn counterclockwise (see Figure 38).
Opening the valve directs the eluent flow path to waste and eliminates
backpressure.

Click Prime on the Chromeleon Control Panel (see Figure 37). The
pump will begin pumping at approximately 3.0 mL/min.

Continue priming the ICS-1500 until no air bubbles are exiting the
pump waste line.

Press Pump Off.

Close the waste valve. Do not overtighten. The pump is now ready
for operation.

NOTE If the two standard priming procedures described above

are unsuccessful, prime the pump with isopropyl
alcohol. See “Chapter 5, Troubleshooting,” in the ICS-
1500 operator’s manual for instructions.
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15 Equilibrating the System

1.

After priming the pump, turn on the pump and set the flow to the operating
rate.

Flush the system for about 5 minutes to equilibrate.

Monitor the system pressure from the Control Panel to make sure it is at the
expected pressure for the installed column (refer to the column manual for
details) and is stable. If the pressure is less than the expected amount, gas may
be trapped in the system. Release the gas by removing the pump fitting on the
injection valve. The fitting is labeled P (2). Allow the air to escape and then
reconnect the fitting.

Check that liquid is flowing out of the suppressor REGEN OUT waste line and
that the pressure is stable.

Monitor the baseline conductivity. In general, it should be <30 uS for a system
set up for anion analyses, and <2 uS for a system set up for cation analyses.
Equilibration time varies and it can take some time to reach these expected
values.

16 Verifying Operational Status

After the system has equilibrated, verify the actual pump pressure and stability by
monitoring the pump pressure reading on the Chromeleon Control Panel (or the
touch screen HOME page). Write down the short-term pressure fluctuations; they
should be less than 0.13 MPa (20 psi).

ICS-1500 installation is complete. For routine operation, refer to /CS-1500 lon
Chromatography System Operator s Manual (Document No. 031917). The
manual is on the Dionex Reference Library CD-ROM (P/N 053891).

40
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17 Connecting an AS50 Autosampler (Optional)

171  AS50 Configuration Requirements

To use an AS50 autosampler with the ICS-1500, the AS50 must meet the
following requirements:

* Aninjection valve cannot be installed in the AS50
¢ The AS50 must have Moduleware version 1.11 or later installed
* Control of the ICS-1500 injection valve must be enabled in the AS50

The following AS50 models are configured at the factory to meet the
above requirements:

® ASS50 without injection valve (P/N 061309)
* ASS50 without injection valve; with sample preparation (P/N 061310)

* ASS50 without injection valve; with sample preparation and sample
tray cooling (P/N 061311)

* AS50 without injection valve; with sample tray cooling (P/N 061312)

Notes

® To identify the version of Moduleware currently installed in the
AS50, go to the AS50 POWER UP screen (press Menu, 8, and 1). If a
Moduleware update is required, contact Dionex.

® In order to use an AS50 that has an injection valve installed, the valve
must be disconnected from the AS50 electronics. Contact Dionex for
assistance. The AS50 electronics components cannot be serviced by
the user.

® [fthe AS50 is currently running with a Thermal Compartment (TC)
or Chromatography Compartment (CC) and you are now going to use
it with an ICS-1500, the injection valve is typically installed in the TC
or CC, not in the AS50. If this is the case, verify that the correct
Moduleware version is installed, and enable control of the ICS-1500
injection valve (see Section 17.3).

After the AS50 is configured for use with the ICS-1500, all AS50 modes
of injection (full-loop, partial-loop, and partial-loop limited-sample) are
supported. In addition, all AS50 injection valve commands (whether
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issued from the AS50 front panel or from Chromeleon) will control the
ICS-1500 injection valve. For Chromeleon control, the AS50 must be
added to the ICS-1500 timebase (see Section 8). For front panel control,
the AS50 and ICS-1500 can be set up for stand-alone operation. This
requires a TTL cable connection between the AS50 and the ICS-1500.
See the TTL appendix in the ICS-1500 operator’s manual for stand-alone
setup instructions.

17.2 AS50 Connections

1. Place the AS50 to the left of the ICS-1500 on the workbench.
2. Open the ICS-1500 and AS50 doors.

3. The needle seal line that extends from the inject port in the
autosampler is coiled inside the AS50 door, on the right side. Route
this line through the AS50 right side slot (see Figure 39) and the ICS-
1500 left side slot to the ICS-1500 injection valve.

The needle seal line from the AS50 inject port to the ICS-1500 injection

valve is calibrated for use with the ICS-1500. To ensure injection
precision, do not shorten (by cutting) or lengthen this line, or replace

it with a different (uncalibrated) line.

Route AS50
needle seal line
to ICS-1500
injection valve

Insert AS50 TRAY
waste line from
ICS-1500 injection
valve here

i

Figure 39. AS50 Drip Tray

42 Doc. 031916-01 3/03



Connecting an AS50 Autosampler (Optional)

4. Connect the needle seal
line from the AS50 to port AS50
S (5) on the injection valve Se:ffﬁ::
(see Figure 40).

The green waste line that is
connected to port W (6) on
the injection valve (see
Figure 40) is connected
with a union to a Teflon
waste line (see Figure 41)
and routed through the
tubing chase to the ICS-
1500 rear panel.

Waste
Line

5. Disconnect the green
waste line (labeled AS50
TRAY) from the union and
route the line to the drip
tray in the autosampler
compartment.

AS50 TRAY
Waste Line

(disconnect
from union)

You can either leave the
disconnected Teflon waste
line and union in the
tubing chase, or pull the
line out from the front.

Figure 41. Injection Valve Waste Line Union

6. Push the end of the green AS50 TRAY line into the small round opening on the
right side of the AS50 tray (see Figure 39).

Make sure the injection valve waste line is not elevated above the
@] injection valve at any point between the valve and the AS50 drip tray.

NOTE For PEEK waste lines, sharply bend the waste line
tubing about 5-mm from the end to ensure it stays in
place in the opening in the drip tray. When bending the
tubing, be sure not to restrict the inner diameter.

7. If you have not already done so, add the AS50 to the Chromeleon timebase
(see Section 8).
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17.3  Enable AS50 Control of the Injection Valve

Follow the steps below if you are connecting an AS50 that was not
configured at the factory for ICS-1500 support. Injection valve control is
already enabled in pre-configured AS50 models (see the list in

Section 17.1).

1. On the AS50 front panel, press Menu and 0 to go to the TIME
FUNCTION OUT screen (see Figure 42). In the LOAD/INECT VALVE:
TTL 1 field, select ENABLED.

TIME FUNCTION OUT

TTL
LOAD/INJECT VALVE: 1  ENABLED
LOAD/INJECT VALVE: 2  DISABLED

Help Prompt

Figure 42. AS50 Time Function Out Screen

2. Turn the AS50 power off and then back on.

All AS50 injection valve commands (whether issued from the AS50
front panel or from Chromeleon) will now control the ICS-1500
injection valve.
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18 Connecting an AS40 Automated Sampler (Optional)

1.

CAUTION

Place the AS40 to the left
of the ICS-1500 on the
workbench.

Open the front door of the
ICS-1500 and thread the
outlet line from the AS40
through the left side slot
at the front of the ICS-
1500.

Connect the outlet line
from the AS40 to port
S (5) of the injection valve

(see Figure 43).

Locate the relay control cable (P/N 047946) supplied with the AS40.

Figure 43. ICS-1500 Injection Valve

Remove the 2-position connector plug from the pair of wires labeled LOAD on

the relay control cable.

Locate the 12-position connector
plug (P/N 923686) in the ICS-
1500 Ship Kit (P/N 057905) (see

Figure 44).

Attach the red wire from the
relay control cable to position 1
on the plug, and attach the green
wire to position 2. This will be
used to connect the AS40 LOAD
relay to RELAY OUT 1 on the
ICS-1500.

Position 1

Position 12

Locking
Screws

Figure 44. 12-Position Connector Plug

To attach a wire to the plug, strip the end of the wire, insert it into the plug,

and use a screwdriver to tighten the locking screw.

When attaching wires to the connector plug, be careful not to allow
stray strands of wire to short to the adjoining position on the

connector.
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NOTE If RELAY OUT 1 is not available, you can connect to
RELAY OUT 2 or to one of the TTL outputs. For RELAY
OUT 2, connect the red wire to position 3 and the green
wire to position 4. For TTL OUT 1, connect the red wire
to position 5 and the green wire to position 11. For TTL
OUT 2, connect the red wire to position 6 and the green
wire to position 12.

8. Connect the relay control cable's 10-position connector plug to the RELAY
CONTROL connector on the AS40 rear panel (see Figure 45).

9. Plug the 12-position connector plug into the TTL and relay connector on the
ICS-1500 rear panel (see Figure 45). Make sure the red wire connects to
position 1 and the green wire connects to position 2.

ICS-1500 Rear Panel AS40 Rear Panel
TTL/Relay Connector
RELAY CONTROL
T £ E s
— v 3 g g
RELAY 2 g R
sl
—
TTLouT 1| © v
(+) 2 Mviol viol/ a9/ {red ] green
u
11 © =
TTLIN 21l o red u grnNot used here
(+) 3o
4 Gt Relay Control Cable
TTLGND 1 ©
) 2f o

Figure 45. Example AS40 Autosampler Connection

The AS40 Load relay is now dedicated to the [CS-1500 RELAY OUT 1. Use this
relay for running with Chromeleon. When you set up the ICS-1500 application
(see Section 12), commands for controlling the AS40 Load relay and switching
the ICS-1500 injection valve are included by default in the program file (see

Figure 46).
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Analog Output Connection (Optional)

5124 Production Test Chromatogram - Commands - |E

m Production Test Chromatograrm

DUPPLCDDUL_\JULLCIIL el =
Flow = 1.50
—-2.300 Pump ECD Relay 1.Closed Duration=138.00 ; For AS40 injection
Relay 1 turned on to start Relay 1 turned off after
0.000 Pump ECD.Rutozero the AS40 Load cycle and 138 seconds

load the sample loop

ECD 1.ARcqon

Pump InjectvValve.InjectPosition Duration=30.00
- AN N
15.000 ECD 1.AcqgoOff Injection valve Injection valve
- switched to Inject switched back
End to Load
4 | o
Figure 46. Example Program for AS40 Control
19 Analog Output Connection (Optional)

20

The analog output connector on the ICS-1500 rear panel outputs an analog voltage
signal proportional to the conductivity measured by the cell. The output is filtered
using the selected data rise time. The analog output can be connected to an
analog-to-digital converter such as an integrator or other recording device. Refer
to the documentation for the device for connection instructions.

Analog output is 0 to 1V, scaled to the selected range.

For an example setup for ICS-1500 stand-alone operation with an AS50
autosampler, see the TTL appendix in the ICS-1500 operator’s manual.

Pressurizing the Eluent Reservoir (Optional)

The ICS-1500 does not require pressurized reservoirs. However, if eluent is
manually degassed or is sensitive to contamination, Dionex recommends
pressurizing the reservoir with helium or nitrogen. The air regulator accessory
bracket and other items needed for pressurizing the eluent reservoir must be
ordered separately (P/N 060054).
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20.1 Connecting the Gas Source (Optional)

L.

Locate the barbed fitting (P/N 030071), pipe thread reducer

(P/N 030087), 3-mm (1/8-in) ID tubing (P/N 040793), and ICS-1500
air regulator accessory (P/N 060054). These parts must be ordered
separately.

Use the barbed fitting and pipe thread reducer to connect the 3-mm
(1/8-in) ID tubing to a clean gas source, regulated to between 0.55
and 0.83 MPa (80 and 120 psi).

Push the other end of the tubing onto the inlet of the air regulator (see
Figure 47).
Remove the eluent reservoir cap.

Connect the gas line from the eluent reservoir cap to the gas line on
the air regulator outlet.

Slip the air regulator accessory bracket over the neck of the eluent
reservoir (see Figure 47).

Eluent Gas Line

Air Regulator
Accessory
Bracket

Gas Inlet Line
3-mm (1/8-in) ID

Connec

gas source /“

-

Figure 47. ICS-1500 Pressurized Eluent Reservoir Connections (Optional)
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Pressurizing the Eluent Reservoir (Optional)

20.2 Pressurizing the Eluent Reservoir (Optional)

NOTE Do not pressurize the ICS-1500 until after the
reservoir is plumbed.

1. Pull out the air regulator knob and turn it fully counterclockwise to
ensure there is no pressure to the reservoir when the gas source is
turned on.

2. Turn on the gas source.

3. Pull out the air regulator knob and turn it clockwise to pressurize the
eluent reservoir.

4. Adjust the pressure to between 30 and 40 kPa (5 and 6 psi). Push the
regulator knob back in.

Do not pressurize the eluent reservoir above 70 kPa (10 psi).

CAUTION
Ne mettez jamais les réservoirs d'éluants sous une pression
supérieure a 0,07 MPa (10 Ib/po?).

MISE EN GARDE
Setzen Sie den Eluentbehilter auf keinen Fall einem Druck tiber 0,07
MPa aus.

VORSICHT
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21  Pump Continuous Seal Wash Connections (Optional)
The pump includes a seal wash assembly that can be set up to continuously rinse
the back of the piston seals to remove salt crystals and prolong the life of the seals.
Follow the steps below to set up this feature.

1. Fill a flush bottle with either deionized water or a combination of deionized
water and 10% or 20% isopropyl alcohol. (Isopropyl alcohol will inhibit
bacterial growth in the water.)

2. Place the flush bottle on top of the ICS-1500. During operation, gravity
maintains flow through the pump heads.

3. The flush solution is carried to the piston seal wash assembly and out to waste
via 1.5-mm (0.06-in) ID tubing (P/N 055847). Locate this tubing in the ICS-
1500 Ship Kit and cut the tubing into three unequal pieces in the following
lengths:
® 117 cm (46 in)
® 152 cm (60 in)
® [5cm(6in)

4. Install the tubing as follows (see Figure 48 and Figure 49):

a. Push the 117-cm (46-in) piece of clear tubing onto the drain tube on the
bottom of the secondary pump head. Place the free end of this tubing in
the flush bottle. Make sure the end of the tubing is near the bottom of the
bottle.

Drain Tube

Drain Tube

Primary Pump

Head
Note: The drain
tubes on the
bottom of each

PSecon:arz pump head are not
ump rea visible in the

photo.

Figure 48. Primary and Secondary Pump Heads with Drain Tubes
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Pump Continuous Seal Wash Connections (Optional)

b. Push the 152-cm (60-in) piece of clear tubing onto the drain tube on the
top of the primary pump head. This is the waste line. Route this waste line
through the lower tubing chase and out the back of the ICS-1500.

c. Push the 15-cm (6-in) piece of clear tubing over the drain tube on the top
the secondary pump head. Push the other end of the tubing over the drain
tube on the bottom of the primary pump head.

d. Place a 10 mL syringe (P/N 054578) at the end of the waste line, press the
syringe against the line to form a seal, and draw out all of the air.

e. Push approximately 5 cm (2 in) of black 0.25-mm (0.01-in) ID tubing
(P/N 057057) into the end of the waste line.

NOTE The black tubing creates a flow restriction. Assuming a
height difference of about 76 cm (30 in) between the
flush bottle and the waste container, this setup provides
a flow of one drop of flush solution every 5 to 30 seconds.

f. Place the end of the waste line in a waste container.

g. This completes the piston seal wash installation. Periodically refill the
flush bottle and empty the waste container as required.

Flush Tubing, 117 cm (46 in) long

Bottle v

/— Primary Pump Head

A v
Secondary Pump Head —/ ‘
A | Tubing, 152 cm (60 in) long
Tubing, 15 cm (6 in) long v
1
Insert black tubing into > Waste
end of waste line Container

Figure 49. Piston Seal Wash Flow Schematic
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22 Manually Connecting to a Control Panel

This section describes how to manually connect the ICS-1500 to a Control Panel
if you do not use the application templates described in Section 12.

1. Inthe Browser, expand the Dionex Templates\Panels\Dionex_IC\ICS-1500
folder. Several System Control Panels, corresponding to various system
configurations, are provided.

2. Open the panel for your system configuration by double-clicking its name in
the list. For example, if your system includes an ICS-1500 and an AS50
autosampler, double-click either ICS-1500_System_ASS50.pan or ICS-
1500_Traditional_System_ASS0.pan.

NOTE The two types of panels (system and traditional
system) are similar in function, but have different
“looks.” You can select either style, depending on
your personal preference.

When the Control Panel opens, the controls on the panel are not enabled (see

Figure 50).
% Pump and Detector - - _ Ol
Sampl Audit Trail
Datasource: |($1) | Elapsed Time: Eem.ﬂmemii -
Sequence: [($1} ] Run Time:
Sample: [(51) | (Systom
program: [51) || _Stortun | stutanmn | -
Pump_ECD.DeviceType} Pump ([Pump_ECD.DeviceType} D
Eluent Bottle, = i | [T G d ‘C " ‘ Signal: ‘ PJ.Signal.Valu(‘ ‘Supp. Type:‘ 3: Cell Temp: 3:
100 Connected Autozerp | Ready Data Rate: 3: SRS Current: 3: SRS Mode: 3: Show Plul...l
= O] 100 {Sample.Sequence]} #{Sample.Number} {Sample.Name} {Wolume;d} from Pos. {Position}
2 old Mode 05
50
= Stop Mode
z 8.0+
p {PumpMo
—
Off On Prime 4.0~
Inject Valve—————————
{Pump_InjectValve.State} 204
Inject Load
Eluent Flow Valve 4
AU T T T T T T T T T !
Closed Open 0.00 0.50 1.00 1.50 2.00 250 3.00 3.50 4.00 4.50 5.00

Figure 50. ICS-1500 Traditional System Control Panel (Unconnected)
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Manually Connecting to a Control Panel

3. To connect the Control Panel to the ICS-1500, open the Control menu and
click the name of the ICS-1500 timebase at the bottom of the menu.

The Control Panel is now connected to the ICS-1500 and the controls are
enabled (see Figure 51).

% 1C5-1500 Pump and Detector with Column Heater - 1€5-1500 - AMAR _|ol x|
Sampl Audit Trail
Datasource: \ \ Elapsed Time: [@915:00:25 User (AMarq) from AMAR has scquired control cver timebase ICS-1500. =
Sequence: | ] RunTime: | |
Sample: | ] em—————————————
Program: | ] rvg‘stanup Shutdown -
1CS-1500 P 1CS-1500 D

IR [ Connected | Autozero | [[RGady | [50n: =] EEYNO oma =] [off =] Show Plot...

# from Pos.

000 ECD_1
0.046

off on | Prime 507

Inject Valve

Inject Load

Eluent Flow Valve 2]

Closed Open =

ICS-1500 Column Heat A= ;

i T T T 1
350°C = 0.00 0.50 1.00 1.50 2.00 2.50 3.00 3.50 4.00 4.50 5.00

Figure 51. ICS-1500 Traditional System Control Panel (Connected to the ICS-1500)
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23 Installation Troubleshooting

Problem: When the ICS-1500 power is turned on for the first time, a Windows
message box appears asking for a USB configuration file (cmwdmusb.inf).

Possible Cause: The USB cable was connected and the power turned on before
Chromeleon was installed.

Solutions:
Use one of the methods below to resolve the problem:

® C(Click the Cancel button on the Windows message box. Turn off the ICS-1500
power and unplug the USB cable. Then, install Chromeleon, reconnect the
USB cable and turn on the ICS-1500 power. Windows will now automatically
recognize the new USB device.

® Leave the message box open and insert the Chromeleon CD into the CD-
ROM drive. Click the Browse button on the message dialog box. The
cmwdmusb.inf file is located in the Drivers folder on the CD.
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